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1 Bienvenido a REAKTOR
 

REAKTOR es un instrumento musical, creador de sonidos. Puede tocarse como cualquier 
otro programa de música. De manera independiente (standalone) con un teclado MIDI o 
como plugin de su secuenciador anfitrión.
Pero, es usted quien define y diseña el tipo de instrumento. REAKTOR está al servicio de 
sus necesidades musicales. ¿Necesita un sintetizador? ¿Un instrumento de percusión? ¿O, 
tal vez, ese dispositivo musical que toque sonidos nunca antes oídos? Simplemente, car­
gue el archivo del instrumento apropiado y empiece a tocar.
La versión completa de REAKTOR viene con más de 50 instrumentos individuales. Tam­
bién comprende una colección de instrumentos de las versiones anteriores de REAKTOR, 
abarcando una historia de más de diez años de música electrónica. Y la biblioteca en línea 
pone a su disposición más de 3000 instrumentos de todos los tipos imaginables.
Si no cuenta aún con la versión completa REAKTOR; puede beneficiarse, sin embargo de 
su gran potencia musical. Existe a su disposición una creciente línea de Instrumentos 
KOMPLETE que pueden emplearse separadamente en REAKTOR. Al cargar alguno de es­
tos instrumentos, REAKTOR pasa automáticamente al modo de reproducción para poder 
ejecutarlos. En el apartado ↑1.2, Modos de REAKTOR: completo, reproductor y demo en­
contrará más detalles.
No obstante, emplear instrumentos preconfigurados apenas araña la superficie. Usted 
puede modificar el procesamiento de señales de su instrumento favorito, ajustar su estruc­
tura interna para cumplir tareas específicas o construir desde cero sus propios instrumen­
tos musicales para dejar su marca personal en el diseño del sonido.
La lectura de este documento lo ayudará a ponerse en marcha.
El equipo REAKTOR de Native Instruments.

1.1 Requisitos de sistema
 

Para obtener información actualizada sobre los requisitos mínimos de sistema y la compa­
tibilidad visite, por favor, nuestra página de Internet:
www.native-instruments.com/REAKTOR

Bienvenido a REAKTOR
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1.2 Modos de REAKTOR: completo, reproductor y demo
 

Lo que pueda lograr con la versión de REAKTOR instalada en su ordenador dependerá del 
modo bajo el cual está operando el programa. Dicho modo está relacionado con el tipo de 
licencia empleada.

▪ Modo completo (Full): si REAKTOR ya está instalado y activado, ya como producto in­
dividual o como parte de un paquete de programas, como KOMPLETE; significa que 
el modo empleado es el completo. En este modo, todas las funciones del programa 
operan sin restricciones.

▪ Modo de reproducción (Player): al instalar alguno de los instrumentos KOMPLETE para 
REAKTOR o un paquete de estos instrumentos como KOMPLETE Elements. REAK­
TOR se instala como una aplicación para reproducir dichos instrumentos. En estos 
casos, REAKTOR operará bajo el modo de reproducción. Bajo este modo, es posible 
tocar los instrumentos y cambiar sus configuraciones, pero no será posible editar su 
estructura interna. El modo de reproducción de REAKTOR no admite la guarda de 
instrumentos, todas las configuraciones respectivas son guardadas dentro del proyec­
to del anfitrión.

▪ Modo Demo: REAKTOR y una cantidad de Instrumentos KOMPLETE han sido instala­
dos pero todavía están sin activar. En este caso, se está empleando una licencia de 
demostración de REAKTOR y REAKTOR está operando en el modo demo. En el modo 
demo, todas las funciones del programa operan sin restricciones pero durante solo 30 
minutos. Además, la función de guardado está deshabilitada.

La instalación y la activación se explican en detalle en la Guía de instalación (Setup Guide) 
que viene por separado.

1.3 ¿Cómo empezar?
 

Este documento le explicará todos los pasos necesarios para empezar a trabajar con 
REAKTOR:

▪ Los capítulos ↑2, Operación básica de REAKTOR y ↑3, Carga y ejecución describen la 
configuración de la aplicación y la carga y ejecución de instrumentos. Esta parte del 
manual es relevante para todos los usuarios.

Bienvenido a REAKTOR
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▪ Los capítulos ↑4, Modificar un ensemble de REAKTOR a ↑9, Lo que viene explican 
las funciones de REAKTOR disponibles en el modo completo. La lectura de estos ca­
pítulos no es necesaria si está empleando REAKTOR en el modo de reproducción.

A continuación, le enseñaremos a realizar las tareas más habituales de REAKTOR. Una se­
rie de guías explicativas le mostrarán como emplear las capacidades de REAKTOR de ma­
nera efectiva y sin abrumadores detalles técnicos. Se aconseja seguir el orden de presen­
tación de estas guías, dado que las posteriores presuponen el conocimiento de las que an­
teceden.

1.4 La documentación de REAKTOR
 

Cuando se haya familiarizado con el uso básico de REAKTOR, seguramente deseará adqui­
rir una información más detallada. La documentación de consulta de REAKTOR contiene 
una descripción detallada de todos los aspectos y características relevantes del programa:

▪ El Manual de consulta de la aplicación explica todos los conceptos fundamentales. En­
seña a manejar la aplicación detalladamente. Si desea usar y entender las capacida­
des de REAKTOR, más allá del nivel expuesto en está guía de iniciación, el manual 
es el punto de partida indispensable.

▪ El Detalle de instrumentos describe todos los instrumentos que vienen con REAKTOR y 
el contenido de fábrica. Lea este documento para explorar en detalle las opciones 
musicales ofrecidas por cada instrumento.

▪ El Detalle de módulos y macros suministra la información pormenorizada de todas las 
partes disponibles a la hora de diseñar sus propios instrumentos. Si desea transitar 
nuevos rumbos, este documento se convertirá en su guía segura.

▪ El Detalle de componentes medulares, es un manual divido en dos partes: la primera 
parte es una guía que explica el nivel medular de REAKTOR, el cual permite la cons­
trucción de dispositivos de procesamiento de señales digitales de bajo nivel. La se­
gunda parte es un listado detallado de todos los componentes del nivel medular.

Esta documentación es especialmente relevante si está empleando el modo completo de 
REAKTOR. Sin embargo, el manual de consulta ofrece una comprensión más profunda 
acerca de como usar los instrumentos de REAKTOR y, por lo tanto, sería bueno echarle un 
vistazo aun empleando REAKTOR simplemente como un reproductor.

Bienvenido a REAKTOR
La documentación de REAKTOR

 

REAKTOR 5.5 - Primeros Pasos - 12



Toda la documentación se encuentra alojada en el menú de ayuda (Help) de REAKTOR.

Además de los manuales que vienen con REAKTOR, podrá encontrar en línea información 
adicional. No deje de visitar el foro de usuarios de Native Instruments en
http://www.native-instruments.com/forum/
La gran comunidad de usuarios de REAKTOR comparte aquí consejos y trucos, y lo asistirá 
en problemas específicos.

1.5 Signos especiales empleados en este documento
 

Este manual utiliza una disposición tipográfica especial para destacar puntos especiales y 
para advertirle sobre posibles problemas. Los signos que presentan estas notas marginales 
indican su naturaleza:

El signo de exclamación distingue las instrucciones o consejos útiles que debería seguir 
cuando correspondiere.

La figura de una lamparita indica información suplementaria de importancia. Esta infor­
mación a menudo lo ayudará a resolver una tarea de manera más eficiente, pero la misma 
no está destinada necesariamente a la configuración o sistema operativo por usted em­
pleado. Sin embargo, es una información que resultará de interés para la mayoría de los 
usuarios.

Bienvenido a REAKTOR
Signos especiales empleados en este documento
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2 Operación básica de REAKTOR
 

REAKTOR 5 puede operar como un programa independiente (standalone) con interfaz pro­
pia para sus equipos de audio y de MIDI. De este modo, es posible ejecutar REAKTOR 
desde cualquier teclado/controlador MIDI conectado al ordenador. De aquí en adelante, 
vamos a suponer que usted está operando REAKTOR como aplicación standalone.
En este capítulo, vamos a aprender la manera de conectar REAKTOR a un dispositivo MI­
DI y al hardware de audio conectado al ordenador. Además, nos servirá también para 
aprender el manejo del programa sin las distracciones que implica el empleo de una EAD.
Antes de empezar a trabajar con REAKTOR 5, realicemos primero las pertinentes configu­
raciones de audio.
Esto solo es válido para la versión standalone de REAKTOR 5, dado que las cuestiones re­
lacionadas con el audio y el MIDI de los plugines de REAKTOR 5 son manejadas por el 
programa anfitrión.

2.1 Configuración del hardware de audio
 

Para poder escuchar el sonido generado por REAKTOR, habrá primero que configurar el 
dispositivo de audio correspondiente (p. ej., la tarjeta de sonido del ordenador o la interfaz 
de audio externa).

Controladores de baja latencia
Siempre que sea posible, utilice controladores de baja latencia. REAKTOR trabaja con dos 
tipos de controladores de baja latencia:

▪ ASIO™
▪ Core Audio™ (solo en ordenadores con Mac OS® X)

Estas tecnologías fueron desarrolladas para asegurar una transferencia de datos eficiente 
entre el programa y el aparato de audio, y deberían proporcionar una latencia aceptable 
incluso para ejecuciones en vivo (aunque no imperceptible).

Operación básica de REAKTOR
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2.1.1 El cuadro de configuración de audio y MIDI
 

Al arrancar REAKTOR por primera vez, el cuadro de configuración de audio y MIDI se abri­
rá automáticamente. Posteriormente, este cuadro podrá abrirse desde el interior del pro­
grama.
1. Haga clic en el botón del Menú para abrir el menú de la aplicación.

2. Seleccione la opción File > Audio and MIDI Settings… :

2.1.2 Seleccionar un dispositivo de audio
 

Para seleccionar el dispositivo de audio a emplear con REAKTOR:
1. Haga doble clic en la aplicación de REAKTOR para iniciarla. A continuación, aparece­

rá el cuadro de configuración de audio y MIDI (Audio and MIDI Settings...).

Operación básica de REAKTOR
Configuración del hardware de audio

 

REAKTOR 5.5 - Primeros Pasos - 15



2. En este cuadro de diálogo, haga clic en el menú denominado Device para abrir la lista 
con las interfaces de audio disponibles. Si solamente hubiera un dispositivo presente, 
el mismo y la frecuencia de muestreo quedarán seleccionados automáticamente. Si 
hubiera dos o más dispositivos instalados en el ordenador, seleccione el que desea 
emplear con REAKTOR, cliqueando en la entrada correspondiente del menú Device.

3. En el menú denominado Driver, seleccione el controlador que desea emplear. En orde­
nadores con sistemas operativos Windows®, lo más recomendable es usar ASIO™. En 
ordenadores con Mac OS® X, la opción preseleccionada es Core Audio™.

Operación básica de REAKTOR
Configuración del hardware de audio
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Ahora que el dispositivo de audio y el controlador correspondiente han sido seleccionados, 
proceda con la selección de una frecuencia de muestreo adecuada.

2.1.3 Seleccionar la frecuencia de muestreo
 

1. Seleccione la frecuencia de muestreo a emplear en el menú denominado Sample Rate. 
Recomendamos seleccionar una frecuencia de muestreo de 44100 Hz.

Operación básica de REAKTOR
Configuración del hardware de audio
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2. Seleccionada la frecuencia de muestreo, pasemos ahora a ajustar la latencia de salida 
del dispositivo de audio.

2.1.4 Ajustar la latencia de salida
 

La latencia de salida permite controlar la rapidez con la que la señal de audio generada 
por REAKTOR se vuelve audible tras tocar alguna tecla de su teclado MIDI. La latencia 
mínima que se pueda conseguir, sin que se produzcan ruidos o fallas, dependerá de la 
cantidad de CPU disponible para el procesamiento de audio. Un ordenador moderno, con­
figurado correctamente, no debería generar ningún tipo de demora perceptible. Ordenado­
res más antiguos, sin embargo, demandarán configuraciones de latencia más laxas. El mo­
do de ajuste de la latencia en el interior de REAKTOR, dependerá del sistema operativo 
empleado.

Operación básica de REAKTOR
Configuración del hardware de audio
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Windows®
1. Haga clic en el botón ASIO Config del cuadro Audio and MIDI Settings… para abrir el 

panel de control del dispositivo de audio.

2. En el panel de control, seleccione una latencia de salida de aproximadamente 10 ms. 
Esta cifra debería andar bien en la mayoría de los ordenadores.

Operación básica de REAKTOR
Configuración del hardware de audio

 

REAKTOR 5.5 - Primeros Pasos - 19



3. Para confirmar, haga clic en OK.

Mac OS® X
1. Mueva el control deslizante de Latency, ubicado al final del cuadro de configuración de 

audio y MIDI, hasta un valor aproximado de 256 samples.

Operación básica de REAKTOR
Configuración del hardware de audio
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2. Para confirmar, haga clic en OK.

2.1.5 Direccionamiento: asignar las entradas de REAKTOR
 

Los canales de entrada de REAKTOR pueden asignarse a cualquiera de las entradas de su 
dispositivo de audio:
1. En el cuadro de configuración de audio y MIDI, haga clic, arriba, en la ficha denomi­

nada Routing (Si está usando Mac OS® X y quiere emplear las entradas integradas de 
su Mac, deberá configurar un dispositivo agregado empleando la aplicación "Audio 
MIDI Setup.app").

2. Haga clic en el botón Inputs para acceder al listado de entradas.
3. Para asignar una de las entradas de REAKTOR a una de las entradas de su dispositivo 

de audio, haga clic en la entrada correspondiente, presente en la columna de la dere­
cha.
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4. Haga clic en OK para confirmar la selección.

2.1.6 Direccionamiento: asignar las salidas de REAKTOR
 

Los canales de salida de REAKTOR pueden asignarse a cualquiera de las salidas de su 
dispositivo de audio:
1. Haga clic en la ficha denominada Routing del cuadro de configuración de audio y MIDI 

(Si está usando Mac OS® X y quiere emplear las salidas integradas de su Mac, debe­
rá configurar un dispositivo agregado empleando la aplicación "Audio MIDI Se­
tup.app").

2. Haga clic en el botón Outputs para acceder al listado de entradas.
3. Para asignar una de las salidas de REAKTOR a una de las salidas de su dispositivo de 

audio, haga clic en la salida correspondiente, presente en la columna de la derecha.
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4. Haga clic en OK para confirmar la selección.

2.2 Configuración del dispositivo MIDI
 

1. Haga clic en la ficha denominada MIDI del cuadro de configuración de audio y MIDI. 
La ventana presentará una serie de opciones según el aparato conectado al ordena­
dor.

2. Haga clic en Off, a la derecha del dispositivo que quiera emplear. El texto pasará a 
On para indicar que el dispositivo ha sido activado.
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3 Carga y ejecución
 

En esta guía explicativa vamos a mostrar la manera de cargar y tocar instrumentos ya exis­
tentes.

▪ Vamos a usar el Buscador para abrir los Ensembles de REAKTOR.
▪ Luego, echaremos un vistazo a las preconfiguraciones de sonidos e instrumentos 

(snapshots).
▪ Finalmente, vamos a enseñarle a guardar el trabajo realizado

Esta guía presupone que REAKTOR ya se encuentra instalado y que dispone de la selec­
ción de fábrica, una colección de Instrumentos KOMPLETE. También da por hecho que 
REAKTOR se emplea como plugin dentro de su secuenciador favorito.

Si ya es propietario de una licencia completa de REAKTOR, no necesita instalar el paquete 
con la selección de fábrica: Carbon 2, el instrumento empleado como ejemplo, se halla pre­
sente dentro del contenido de fábrica, en la sección New Additions > Synthesizers.

3.1 Algunos botones importantes
 

Antes de empezar, será importante familiarizarse con cuatro botones muy importantes que 
se encuentran en la Barra principal y en el Panel lateral

▪ El botón del panel lateral (Sidepane) de la barra principal sirve para abrir o cerrar el 
panel lateral. El panel lateral aloja las fichas Browser (Buscador), Snapshot, Panelsets (Pa­
neles), y Properties (Propiedades).

Ilust. 3.1 El botón del Panel lateral

▪ Haga clic en la ficha Browser para abrir el buscador de archivos de REAKTOR.

Ilust. 3.2 La ficha del Buscador
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▪ Haga clic en el botón Snapshot para abrir el buscador de snapshots; utilizado para car­
gar, guardar y modificar preconfiguraciones de instrumentos.

Ilust. 3.3 El botón Snapshot

▪ Para acceder al menú global, vamos a usar siempre el botón del Menú. Sin embargo, 
todas las opciones utilizadas también pueden abrirse desde el menú de la aplicación.

Ilust. 3.4 El botón del Menú

Ilust. 3.5 El menú de la aplicación (File) (versión Windows®)
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El menú de vistas (View) también permite acceder a todas las vistas de REAKTOR ofrecidas 
por las opciones del menú global. Por cuestiones de brevedad, solamente se hace mención de 
este aspecto en el manual de iniciación.

Tenga presente estos botones porque serán necesarios para el desarrollo de nuestra expli­
cación. Ahora, vayamos al buscador para cargar nuestro primer ensemble de REAKTOR.

3.2 Ensembles, Instrumentos e Instrumentos KOMPLETE
 

Además de los botones ya mencionados, deberá recordar las denominaciones siguientes, 
ya que son habitualmente empleadas por la comunidad de REAKTOR y serán de uso fre­
cuente a lo largo de las guías de este manual:

▪ Un Ensemble es un juego de instrumentos que se puede cargar directamente en 
REAKTOR. El mismo puede ser un solo sintetizador o una tira de canales con varios 
efectos. Los instrumentos están mutuamente interconectados y se hallan conectados 
a la salida y entrada de audio de la aplicación. Al guardar, normalmente emplearemos 
el formato de archivo de ensemble.

▪ Un Instrumento forma parte de un ensemble, por ejemplo, una unidad de efecto de re­
tardo. Los instrumentos se cargan dentro de un ensemble y se conectan a las salidas 
y entradas de audio de la aplicación.

▪ Un Instrumento KOMPLETE es el único archivo que se puede utilizar cuando solo se po­
see una licencia de reproductor. Técnicamente se parece mucho a los ensembles (en 
la conexión de entradas y salidas, por ejemplo), pero se lo denomina instrumento da­
do que conforma una unidad cerrada desde el punto de vista musical.

3.3 Cargar Carbon 2
 

Vamos a cargar Carbon 2, un sintetizador sustractivo de la biblioteca de fábrica de REAK­
TOR.

3.3.1 Abriendo el panel lateral
 

Si al arrancar el programa el panel lateral no estuviera visible, ábralo cliqueando en el bo­
tón respectivo (Sidepane) de la barra principal.
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Ilust. 3.6 El botón del Panel lateral

3.3.2 Abrir el buscador
 

Abierto el panel lateral, haga clic en la ficha del buscador (Browser) o pulse [F5] en el te­
clado de su ordenador.

Ilust. 3.7 La ficha del Buscador

A continuación, aparecerá el buscador de archivos. El mismo está dividido en tres partes: 
arriba de todo hay cuatro botones que abren distintos contenidos. Debajo aparece un di­
rectorio de archivos. Más abajo, aparece el listado de los archivos de la carpeta seleccio­
nada en el directorio.
Ahora, haga clic en el botón denominado Player. Verá aparecer la lista de todos los Instru­
mentos KOMPLETE. Seleccione la selección de fábrica de REAKTOR con un clic del ra­
tón.
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Ilust. 3.1 El Buscador con la selección de fábrica seleccionada

El botón situado junto al botón Player se denominará según la activación de REAKTOR: tras la 
activación de REAKTOR, el botón abrirá el contenido de fábrica del programa y se denominará 
"Factory". Hasta entonces, será denominado con la palabra "Demo". Esto significa que REAK­
TOR pasará al modo demo cuando se cargue cualquier ensemble procedente de fábrica.
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3.3.3 Cargar un archivo
 

Al seleccionar la selección de fábrica de REAKTOR, la lista de los instrumentos correspon­
dientes aparecerá en la parte inferior del buscador. Haga clic en la entrada correspondien­
te a Carbon 2 y arrástrela hasta el área principal de la aplicación. REAKTOR pasará a car­
gar dicho archivo.

3.4 Ejecutar Carbon 2 y sus snapshots
 

Ilust. 3.2 Carbon 2 cargado en REAKTOR PLAYER

Carbon 2 es un clásico sintetizador sustractivo con osciladores, filtros, fuentes de modula­
ción y unidades de efectos.
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Consulte el Detalle de instrumentos para una explicación detallada del Carbon 2 o la docu­
mentación que viene con la selección de fábrica de REAKTOR.

3.4.1 Cargar un snapshot
 

Toque algunas notas en su teclado MIDI para hacerse una idea del sonido del sintetizador. 
Luego, cambie el sonido completamente cargando un snapshot diferente.
En la terminología de REAKTOR, un snapshot puede estar constituido por un sonido, un 
preset o un parche. Cada instrumento puede tener distintos snapshots y, al cargar alguno 
de éstos, los controles del instrumento se ajustarán según valores específicos, recreando 
así un sonido en particular.
Los snapshots de Carbon 2 se abren desde el control central en la barra principal de la 
aplicación.
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Ilust. 3.3 El control de Snapshots

1. Haga clic en el control de Snapshot para abrir el menú desplegable. El menú contie­
ne todos los snapshots del instrumento.

2. Seleccione In Deep.
3. Toque algunas notas para escuchar la diferencia.
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3.5 Ajustar el sonido
 

En este apartado, aprenderemos a manejar un sonido a través de algunos ajustes básicos.

3.5.1 Cambiar efectos
 

In Deep es un snapshot que emplea profusamente el efecto de retardo para crear un soni­
do espacioso. Supongamos que la canción sobre la que está trabajando no requiere de es­
te tipo de espacio: apague el efecto haciendo clic en el botón Delay. En lugar del retardo, 
vamos a añadir amplitud coral, haciendo clic en el botón Chorus.

Ilust. 3.4 La ficha de efectos (Effects) con los efectos de coro (Chorus) y ecualización (EQ) activados

3.5.2 Cambiar el movimiento del filtro
 

También vamos a cambiar el movimiento del filtro.
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1. Para manipular el movimiento del filtro, pase al costado derecho del instrumento, a la 
sección de fuentes (ficha Source)

2. En la parte inferior de la sección de fuentes, seleccione LFO1 haciendo clic en la ficha 
correspondiente.

3. Cliquee la perilla denominada Rate y gírela hacia arriba para incrementar el valor has­
ta 8.

4. Toque una nota: la velocidad de movimiento del filtro se ha duplicado.

Ilust. 3.5 La sección del LFO de la ficha de fuentes (Source) tras los cambios aplicados

3.5.3 Cambiar la configuración del filtro
 

Para modificar el filtro propiamente dicho:
1. En la sección de filtros del instrumento, haga clic en la perilla de resonancia (Resonan­

ce) y arrastre hacia arriba hasta que su valor llegue a 0.5.
2. Póngale un poco de brillo al sonido incrementando el valor del recorte; haga clic en la 

perilla Cutoff y arrastre hacia arriba.

Carga y ejecución
Ajustar el sonido

 

REAKTOR 5.5 - Primeros Pasos - 34



Ilust. 3.6 La sección de filtros tras los cambios aplicados

3.6 Guardar los ajustes efectuados
 

Hay dos maneras de guardar los cambios efectuados al sonido:
▪ Store your host’s project file: es la opción más común a la hora de componer y la única 

posible cuando REAKTOR opera en el modo de reproducción. Al guardar el trabajo, la 
aplicación anfitriona extrae del plugin de REAKTOR toda la información necesaria pa­
ra recuperar la configuración realizada y guarda dicha información dentro del proyecto 
anfitrión. Cuando cargue nuevamente el proyecto anfitrión, REAKTOR volverá a gene­
rar la situación vigente.

▪ Store the Ensemble file: esta opción solo es posible en el modo completo de REAK­
TOR. En este caso, lo que se crea en un copia modificada del archivo cargado al co­
mienzo de este tutorial. De esta forma, al cargar el instrumento modificado, en vez 
del original, podemos emplear el sonido modificado sobre una canción diferente
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Consulte la documentación de su programa anfitrión para más detalles sobre la forma de guar­
dar sus proyectos.

Para guardar el archivo del ensemble como una copia del instrumento original, seleccione 
la opción Save As… del menú de la aplicación. A continuación se abrirá una ventana en la 
que podrá seleccionar una carpeta e ingresar el nombre del archivo. Tras realizar estas ac­
ciones, haga clic en el botón Save.
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4 Modificar un ensemble de REAKTOR
 

En esta guía aprenderemos:
▪ A modificar un ensemble de REAKTOR. El ensemble se llama Junatik y es la agrupa­

ción de dos instrumentos: un sintetizador y un retardo.
▪ A insertar un instrumento de reverberación en la agrupación y conectarlo con el sinte­

tizador.
▪ A remover el instrumento de retardo de la agrupación.
▪ Algunos aspectos suplementarios del sistema de snapshots de REAKTOR.
▪ A emplear el buscador para cargar el ensemble Junatik y para insertar un instrumento 

de reverberación.

Si está empleando REAKTOR PLAYER, no necesita seguir leyendo más. Completada la lectura 
de los capítulos 2 y 3, ¡ya puede empezar a tocar!

4.1 Recapitulación
 

En esta primera guía hemos aprendido a crear y guardar snapshots con el botón Append. 
También hemos guardado nuestro trabajo con el comando Save Ensemble As.... Dado que 
vamos a seguir empleando estos elementos, no sería una mala idea repasar lo aprendido 
hasta ahora antes de continuar.

Empleo de los botones de REAKTOR
Los botones utilizados hasta ahora son:

▪ El botón del panel lateral (Sidepane) de la barra principal, utilizado para abrir o cerrar 
el panel lateral. El panel lateral aloja el buscador, los snapshots, los paneles y las 
propiedades.

Ilust. 4.1 El botón del Panel lateral

▪ Haga clic en la ficha del Buscador para abrir el buscador.
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Ilust. 4.2 La ficha del Buscador

▪ Haga clic en la ficha de Snapshots para abrir la lista de snapshots.

Ilust. 4.3 La ficha Snapshot

En esta guía vamos a aprender las propiedades de REAKTOR. También vamos a usar el 
botón de estructuras del ensemble.

▪ Haga clic en la ficha de Propiedades para abrir las propiedades de los ensembles, ins­
trumentos, macros, módulos y demás elementos de REAKTOR.

Ilust. 4.4 La ficha de Propiedades

▪ Haga clic en el botón de Estructuras para abrir la estructura de REAKTOR.

Ilust. 4.5 El botón de Estructuras

Tenga presente estos botones porque los empleará con frecuencia, especialmente, cuando 
veamos el uso de REAKTOR como plugin.

4.2 Empleo del buscador para cargar un ensemble
 

Esta vez, vamos a usar el buscador para cargar un ensemble.
1. Cliquee en el botón Sidepane para abrir el panel lateral.
2. Luego, cliquee la ficha del Buscador para abrir el buscador.
3. Haga clic en Factory para recorrer la biblioteca de fábrica.
4. Sírvase del directorio de archivos que aparece en la parte superior del buscador y vaya 

hasta Ensembles > Classics > Synthesizer. La lista de los sintetizadores debería apa­
recer en la parte inferior del buscador.

5. En dicha lista, haga clic en Junatik para abrirlo.
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Ilust. 4.6 Junatik en el buscador

4.3 Ensembles: agrupaciones de instrumentos
 

En este apartado vamos a ver la relación jerárquica entre los instrumentos y los ensembles 
de REAKTOR.

Modificar un ensemble de REAKTOR
Ensembles: agrupaciones de instrumentos

 

REAKTOR 5.5 - Primeros Pasos - 39



4.3.1 El panel de Junatik
 

Ilust. 4.7 El sintetizador de Junatik con el StereoTDelay oculto.

Veamos el aspecto de Junatik. Se trata, por supuesto, del sintetizador identificado con el 
nombre de Junatik. Debajo del sintetizador, vemos el instrumento llamado StereoTDelay. 
Para que la vista del ensemble guarde cierto orden, los instrumentos integrantes se abren 
o se cierran según necesidad. Aquí, el StereoTDelay aparece cerrado.

▪ Haga clic en el botón A, ubicado abajo, para abrirlo. Al cliquear en el botón de la raya 
(—), junto a los botones A y B, volverá a cerrar el instrumento.
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Ilust. 4.8 StereoTDelay abierto

4.3.2 La diferencia entre un ensemble y un instrumento
 

Cuando estábamos trabajando con el 2-Osc, el retardo estaba integrado al sintetizador. 
Aquí, el retardo es un instrumento independiente. REAKTOR denomina ensemble a la 
agrupación de dos o más instrumentos. En nuestro ejemplo, el ensemble aloja en su inte­
rior dos instrumentos: el sintetizador Junatik y el retardo StereoTDelay.
En la terminología de REAKTOR, un instrumento puede ser tanto un instrumento en el 
sentido tradicional (p. ej., un sampler o un sintetizador) como también un efecto (p. ej., 
un retardo o un reverberado) o cualquier otra cosa, como secuenciadores o incluso una 
ilustración.
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Ilust. 4.9 El instrumento Junatik

Ilust. 4.10 El instrumento Delay
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Toque algunas notas y escuche el sintetizador y el retardo. Cambie algunos snapshots para 
escuchar sonidos diferentes. Dado que el Junatik está integrado por un sintetizador y un 
instrumento de efectos, el sistema de snapshots es ligeramente diferente.

4.4 Snapshot maestro de un plugin y orden de prelación de los 
snapshots

 

Si observamos la parte superior del ensemble, vamos a ver un panel denominado Ens – Ju­
natik.

Ilust. 4.11 Panel del ensemble

En el panel del ensemble aparece seleccionado el snapshot número 83 – Berlín ambience 
II.

4.4.1 La jerarquía de snapshots vista desde las propiedades del programa
 

Para entender la jerarquía de snapshots, es necesario abrir el cuadro de propiedades del 
programa. Para hacer esto:
1. Haga clic sobre Ens – Junatik. Alternativamente, también puede cliquear en la ficha de 

propiedades del panel lateral.

2. Cliquee el botón Function para abrir la página de funciones de las propiedades de Juna­
tik.
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Ilust. 4.12 El botón de funciones

Ilust. 4.13 Las propiedades del ensemble con la opciones "Recall by MIDI" y "Snapshot Master for Plugin" seleccionadas.
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Observe ahora el área correspondiente a Snapshot. Notará que las casillas de Recall by MIDI y 
Snapshot Master for Plug-In se encuentran marcadas.

4.4.2 Opciones Recall By MIDI y Snapshot Master for Plugin
 

▪ Snapshot Master for Plugin significa que cuando estos snapshots sean cambiados por 
el Ensemble (master), los snapshots del sintetizador y del retardo también cambiarán. 
En otras palabras, los instrumentos Junatik y StereoTDelay son esclavos del ensemble 
maestro.

▪ Recall by MIDI significa que este instrumento puede recibir mensajes MIDI de cambio 
de programa. Si el maestro también tiene esta opción y está sobre el mismo canal MI­
DI, el snapshot del maestro tendrá prelación.

4.4.3 Propiedades de los snapshots del instrumento Junatik
 

Al cliquear el panel de Junatik, aparecerá el correspondiente cuadro de propiedades con la 
opción Recall by Parent seleccionada.

Ilust. 4.14 El área de Snapshot del cuadro de propiedades del instrumento Junatik, con la casilla "Recall by Parent" marca­
da.

Esto confirma que los snapshots del panel del ensemble son los snapshots maestros.
Cambie ahora algunos snapshots y verá que, algunas veces, los snapshots del instrumento 
Junatik no siempre se corresponderán con snapshots equivalentes en el instrumento Ste­
reoTDelay. Seleccionemos, por ejemplo, Snapshot “24 – Pointer 1”. Observará que el 
snapshot del StereoTDelay dice 1 – Delay off. Pruebe, entonces, con otros snapshots del 
instrumento Junatik para ver qué es lo que sucede.
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4.4.4 Snapshots con el interruptor apagado
 

Habrá notado que los snapshots del Instrumento Junatik se reproducen sin el efecto de 
retardo: el Snapshot 1 del StereoTDelay tiene el retardo apagado porque el interruptor On, 
encima de la perilla Wet, está apagado.

Ilust. 4.15 El retardo está apagado

Este interruptor no solo silencia el instrumento, también ahorra consumo de CPU. Por lo 
tanto, si emplea este ensemble en una EAD y prefiere usar los efectos de la EAD, tendrá 
sentido, entonces, apagar este interruptor.

4.4.5 Flexibilidad de los snapshots
 

Por supuesto, si quiere cambiar el snapshot del instrumento StereoTDelay, podrá elegir 
entre distintos presetes de retardo sin tener que cambiar el snapshot del sintetizador. Así 
es como el sistema de snapshots se convierte en un sistema flexible que permite trabajar 
con distintas opciones: diferentes instrumentos con snapshots diferentes o una opción 
maestra que permite cambiar los snapshots de varios instrumentos.

4.5 Cambiar el instrumento de retardo por un instrumento de 
reverberado

 

El sintetizador de Junatik nos gusta mucho pero ahora queremos saber cómo sonaría con 
un reverberado. Vamos a reemplazar entonces el retardo por uno de los reverberados de 
REAKTOR.

Modificar un ensemble de REAKTOR
Cambiar el instrumento de retardo por un instrumento de reverberado

 

REAKTOR 5.5 - Primeros Pasos - 46



4.5.1 Abrir la estructura interna de un ensemble
 

Para hacer esto, tenemos que ver cómo es la estructura del ensemble.
▪ Haga clic en el botón de Estructuras del panel lateral.

Ilust. 4.16 El botón de Estructuras

A continuación se abrirá la ventana con la estructura del ensemble.

Ilust. 4.17 Estructura del ensemble de Junatik

Como puede apreciar, el sintetizador Junatik está conectado con el StereoTDelay. Las sali­
das izquierda (L) y derecha (R) del Junatik están conectadas a las entradas izquierda y de­
recha del StereoTDelay. Y las salidas izquierda (L) y derecha (R) del StereoTDelay están 
conectadas a las salidas de audio.
Lo que haremos a continuación es usar el buscador para insertar un instrumento de rever­
berado. Y luego, lo conectaremos con el Junatik. Pero antes de hacer todo esto, primero 
tenemos que sacar el StereoTDelay de la estructura.
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4.5.2 Eliminar un instrumento de la estructura
 

Para eliminar el retardo de la estructura de este ensamble:
1. Al cliquear con el botón derecho del ratón (o ejecutando [Ctrl]+clic en Mac Os® X) 

sobre el esquema del StereoTDelay representado en la ventana de estructuras, se 
abrirá un menú contextual.

2. En dicho menú, haga clic en Delete para borrar el instrumento de la estructura.

Ilust. 4.18 Borrando un instrumento

El Instrumento StereoTDelay ha sido eliminado dentro de la estructura.
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4.6 Buscar instrumentos con el buscador
 

Vamos a reemplazar el retardo por un instrumento de reverberación. Usemos el buscador 
para cargar el archivo "SpaceMaster.ism".
1. En el panel lateral, haga clic en la ficha del Buscador para abrir el buscador de REAK­

TOR.

2. En el directorio del buscador, vaya hasta Instruments > Effects.
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3. En la parte inferior del buscador, cliquee y arrastre el archivo Space Master 1 – Stereo.ism 
hasta la ventana de estructuras. El instrumento será insertado en la estructura del en­
semble.
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Ilust. 4.19 SpaceMaster ha sido insertado dentro de la estructura

Para agregar instrumentos, también puede cliquear dos veces en la estructura y usar el menú 
contextual.
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Ilust. 4.20 El instrumento SpaceMaster

4.7 Conectar el instrumento a la salida de audio
 

Ahora, tenemos que conectar el Junatik con el SpaceMaster y a éste, con las terminales de 
la salida de audio.

4.7.1 Efectuar las conexiones
 

1. Haga clic y mantenga cliqueada la salida L (o el puntito a su lado) del instrumento 
Junatik y arrastre el ratón hasta la entrada L de SpaceMaster. Al hacer esto, verá que 
el cursor (convertido en una mano) arrastra un cable hasta el otro instrumento. Al lle­
gar hasta la entrada L del SpaceMaster, suelte el botón del ratón.
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2. Repita la misma operación para el resto de las conexiones (incluyendo la conexión de 
las salidas izquierda y derecha del SpaceMaster con las entradas 1 y 2 de las termi­
nales de la salida de audio.

Completada la operación, la ventana debería ofrecer el siguiente aspecto:

Ilust. 4.21 SpaceMaster conectado a Junatik y a las salidas de audio.

Ahora, tenemos que verificar como están nuestros instrumentos en el panel Ensemble.

4.7.2 Restablecer la posición de los instrumentos en el panel del ensemble
 

Cabe la posibilidad de que al efectuar la inserción del instrumento, el SpaceMaster haya 
quedado encima del Junatik en el panel del ensemble (si esto no ha sucedido, puede sal­
tear la lectura de este apartado). Para cambiar la posición, haga lo siguiente:
1. Vaya hasta la vista de paneles presionando el botón de Panel en la barra lateral.

2. Seleccione el panel del SpaceMaster (haciendo clic en el nombre del instrumento).
3. Luego, haga clic y arrastre el instrumento para situarlo debajo del Junatik. Una vez 

debajo, suelte el botón: el Junatik habrá quedado nuevamente arriba.
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Ilust. 4.22 Junatik ocupando la parte superior

4.8 Restaurar la jerarquía correcta de snapshots
 

Al insertar el SpaceMaster dentro de la estructura, hemos alterado la jerarquía de snaps­
hots. Tenemos que restaurar la jerarquía maestra, en la cual los snapshots del ensemble 
son los que tienen la prioridad. Vamos a tener que cambiar, entonces, algunas propieda­
des de los instrumentos Junatik y SpaceMaster.
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4.8.1 Abrir las propiedades del instrumento
 

Primero, tenemos que habilitar la opción "Snapshot Master for Plug-in" para el Ensemble 
Junatik y habilitar la opción "Recall by Parent" para el SpaceMaster.
1. En el panel lateral, haga clic en la ficha de Propiedades.

2. Cliquee en la cabecera de Ens – Junatik. Esto abrirá las propiedades del Ensemble 
Junatik.

3. Haga clic en el botón Function.

4. Ahora, marque la casilla de Snapshot Master for Plugin de la sección Snapshot.

5. Ahora, haga clic en el panel del SpaceMaster (cliquear sobre el nombre del instru­
mento). A continuación, se abrirá el cuadro de propiedades.

6. Active la casilla de Recall by Parent.
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5 Crear un sintetizador secuenciado
 

En esta guía vamos a crear un sintetizador-secuenciador

5.1 Recapitulación 
 

Al trabajar con el Ensemble Junatik, vimos que el ensemble estaba compuesto por un ins­
trumento sintetizador (el Junatik) y un instrumento de retardo (el StereoTDelay). Ahora, 
vamos a crear un ensemble que empleará dos instrumentos de REAKTOR. Uno de ellos es 
un secuenciador llamado Monoliner y el otro, un sintetizador llamado Soundschool Analog 
(o ANALOG para abreviar).
Monoliner emula un clásico secuenciador de pasos con tres hileras de perillas y Sounds­
chool Analog es un sintetizador semimodular de 2 osciladores.
Vamos a efectuar las conexiones necesarias de MIDI y de audio para que el secuenciador 
pueda accionar el sinte.
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Ilust. 5.1 Monoliner y Soundschool Analog (ANALOG).

5.2 Crear el ensemble de sintetizador y secuenciador
 

Debemos empezar con un ensemble vacío y luego ir poniendo los instrumentos

5.2.1 Crear un ensemble nuevo
 

▪ Para crear un nuevo ensemble, haga clic en el botón del Menú y seleccione File > New 
Ensemble.
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Ilust. 5.2 La opción New Ensemble del menú global.

Ilust. 5.3 Aspecto del panel de un nuevo ensemble

También puede utilizar el atajo de teclado [Ctrl]+N (Windows®) o [Cmd]+N (Mac OS® X) para 
crear un ensemble nuevo.

5.2.2 Usar el buscador para cargar los instrumentos
 

1. En el panel lateral, pulse la ficha del Buscador para abrir el buscador.
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2. Pulse el botón Factory para abrir la biblioteca de fábrica.

3. A continuación, sírvase del directorio de archivos para ir hasta Instruments > Sequen­
cers.

4. En el cuadro inferior del buscador, arrastre el archivo Monoliner.ism hasta el área del pa­
nel a la derecha. El Monoliner será insertado dentro del ensemble.
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Ahora, vamos a cargar el Soundschool Analog.
1. Vaya hasta la entrada Instruments > Synthesizers del directorio.
2. Recorra los archivos hasta dar con SoundSchool Analog.ism.
3. Cliquee y arrastre el archivo SoundSchool Analog.ism hasta el área del panel a la derecha.
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Ilust. 5.4 Insertando SoundSchool Analog en el ensemble

5.3 El sintetizador-secuenciador en acción
 

Vamos a necesitar hacer algunas conexiones de audio y de MIDI entre el Monoliner y el 
SoundSchool Analog.
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5.3.1 Panorama de la estructura interna
 

Cargados los instrumentos, la estructura debería tener el aspecto siguiente:

Ilust. 5.5 Estructura del ensemble con los instrumentos Monoliner y ANALOG

Podemos ver los instrumentos Monoliner y ANALOG, y también un instrumento vacío (pre­
determinado) que está conectado a las entradas y salidas de audio.

5.3.2 Eliminar el instrumento predeterminado
 

▪ Haga clic con el botón derecho del ratón (Windows®) o [Ctrl]+clic (Mac OS® X) sobre 
la parte superior del instrumento y seleccione la opción Delete en el menú contextual.
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Ilust. 5.6 Eliminación de un instrumento empleando el menú contextual

Conectemos ahora las salidas L y R de ANALOG con las entradas 1 y 2 de las terminales 
de la salida de audio.

5.3.3 Conectar las salidas de ANALOG con la salida del audio
 

Seguramente, todavía recuerda esta operación por haber conectado el sintetizador Junatik 
y el reverberador SpaceMaster.
1. Haga clic y arrastre a partir de la L (o el puntito a su lado): mientras ejecuta está ac­

ción, verá formarse un "cable" de conexión a medida que arrastra el ratón hacia la en­
trada de la primera terminal de la salida de audio. Llegado a destino, suelte el ratón y 
la conexión habrá quedado establecida.

2. Repita el procedimiento para la salida R y la terminal 2 de la salida de audio.
La estructura debería tener ahora el siguiente aspecto:
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Ilust. 5.7 ANALOG con sus salidas de audio conectadas.

Como puede ver, hemos conservado el instrumento Master porque cuenta con un conve­
niente control maestro de volumen. Ahora, tenemos que verificar como están estos dos 
instrumentos en el panel Ensemble.

5.3.4 Panorama de Monoliner y ANALOG
 

▪ Para ir hasta el panel de la vista del ensemble, pulse el botón Panel.

Ilust. 5.8 El botón de Panel
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Ilust. 5.9 Monoliner y ANALOG

Como puede apreciar, Monoliner tiene tres hileras de perillas que controlan, respectiva­
mente, la supresión de ruidos, la velocidad y el tono. La sección snc&pos, a la izquierda, 
controla la velocidad y la dirección de la reproducción del secuenciador, y la manera en 
que muchos pasos se usan. Más adelante, echaremos un vistazo a los otros controles. Y 
muy importante: Monoliner presenta una salida MIDI integrada.
ANALOG presenta 2 osciladores con modulación anular, 2 envolventes, un LFO y un retar­
do estéreo incorporado.

5.4 Efectuar la conexión MIDI entre los instrumentos
 

Monoliner es un instrumento que fue programado para enviar MIDI a otros sintes de 
REAKTOR y, también, a sintetizadores externos. Tenemos que realizar ahora una pequeña 
conexión dentro de este ensemble. Afortunadamente, esto es una operación muy sencilla.
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5.4.1 Emplear las conexiones MIDI internas
 

Para direccionar internamente la salida MIDI del Instrumento Monoliner hacia la entrada 
MIDI de ANALOG, deberá ir hasta la página de conexiones de las propiedades de Monoli­
ner.
1. En el panel lateral, haga clic en la ficha de Propiedades.

2. Ahora, haga clic en el botón Connect para abrir la página de conexiones.

3. Para efectuar la conexión MIDI entre el secuenciador y el sinte, vaya hasta el menú 
Select Instruments de la sección MIDI Out. Haga clic en dicho menú desplegable y selec­
cione la entrada ANALOG.

4. Para comprobar si la conexión ha sido hecha, vaya hasta la página de conexiones del 
Instrumento ANALOG. Haga clic, entonces, en la cabecera del Instrumento ANALOG 
para seleccionarlo.
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5. La página de conexiones de ANALOG debería aparecer en el panel lateral. Haga clic 
en el menú desplegable de Select Instruments, en la sección MIDI In. Notará que la casilla 
junto a la entrada de Monoliner aparece marcada.

6. Ahora tiene que guardar el trabajo con el comando Save Ensemble As…del menú glo­
bal. Y ahora pruebe cómo funciona esta combinación de secuenciador y sintetizador.

5.5 Los botones de ejecución y parada de REAKTOR
 

Los botones de Ejecución y Parada de REAKTOR serán usados para iniciar y detener el se­
cuenciador.

Panorama de los botones de ejecución y parada
Los botones de Ejecución y Parada se encuentran en la barra de herramientas principal, en la 
parte superior del instrumento, junto al indicador de BPM.

Ilust. 5.10 BPM/Ejecución/Parada
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▪ Para accionar el secuenciador, haga clic en el botón de Ejecución. El secuenciador em­
pezará a funcionar. Los indicadores de actividad MIDI se iluminarán para confirmar la 
existencia de una conexión MIDI. También debería escuchar los sonidos que salen del 
sintetizador.

Ilust. 5.11 Las luces de actividad MIDI

Pausar y restablecer el secuenciador
▪ Mientras el secuenciador está operando, un solo clic sobre el botón de Ejecución lo 

pondrá en pausa; al cliquear nuevamente sobre dicho botón, la reproducción conti­
nuará a partir de ese punto. Un clic en el botón de Parada pondrá el secuenciador nue­
vamente al comienzo de la pauta.
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5.6 El Monoliner visto de cerca.
 

Observemos ahora los controles de velocidad y dirección con un poco de más atención.

5.6.1 Cambiar la velocidad y la dirección
 

Este secuenciador es muy flexible en su manera de reproducir las pautas.
▪ Para invertir la dirección de la reproducción y ponerle algunos rasgos aleatorios, abra 

la lista de direcciones (haga clic en la flecha de dirección). Similarmente, podrá modifi­
car la velocidad haciendo clic en el menú de sincronización (sync).

Ilust. 5.12 Direcciones
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Ilust. 5.13 Velocidades

El valor por defecto es 1/16, lo cual divide un compás en 16avos de nota (semicorcheas).

5.6.2 Número de pasos, diferencia entre pasos y control shuffle/swing
 

▪ La perilla stps cambia el número de pasos (entre 1 y 16).
▪ La perilla offs desplaza hasta el punto desde donde comienza el secuenciador.
▪ La perilla SHFL pone más swing a la reproducción. Haga la prueba de cambiar el nú­

mero de pasos a 6 y luego desplace la diferencia hasta 9.

5.6.3 Las perillas GATE, VELO y PITCH, y los botones de encendido/apagado
 

▪ La fila superior de perillas (GATE) se usan para programar la duración de cada acciona­
miento.

▪ La perilla del final es la perilla maestra y afecta todas las duraciones.
▪ La hilera siguiente, denominada VELO, programa el volumen de cada accionamiento. 

También cuenta con un control maestro.
▪ La última fila de perillas, denominada PITCH, es para el tono.
▪ La fila de botones controla el encendido y apagado de Gate.
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Ilust. 5.14 Las perillas maestras

Ilust. 5.15 Los botones de encendido y apagado de Gate.

5.7 Explorar la información de los snapshots
 

Vamos a ver la información concerniente al secuenciador y al sinte.

5.7.1 Explorando los snapshots de Monoliner y de Analog
 

Monoliner solo tiene pocos presetes pero todos muy buenos. Lo divertido de este secuen­
ciador es cambiar las direcciones y el número de los pasos y sus diferencias (con los con­
troles de snc&pos), porque así obtendremos una amplia gama de variaciones. También 
resulta interesante aleatorizar las configuraciones haciendo uso del botón rnd. El sintetiza­
dor ANALOG tiene muchos más snapshots y resulta muy productivo ir cambiándolos du­
rante la reproducción de una secuencia.

5.7.2 Mostrar y ocultar la información
 

Es aconsejable que la opción de mostrar la información se encuentre activada (pulsar el botón 
de la información). Al posar el ratón sobre los controles del sintetizador, descubrirá notas muy 
informativas.
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Ilust. 5.16 Información de la perilla FM.

Cuando haya terminado de investigar los distintos elementos, asegúrese de guardar otra 
vez su trabajo.
Recuerde que si desea grabar encima de la versión guardada previamente, puede usar el 
comando Save Ensemble del menú global. O también puede usar la opción Save Ensemble 
As... para conservar la versión anterior y la nueva (con un nombre modificado).
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6 Explorar el sampler de REAKTOR
 

En esta guía vamos a trabajar con el Memory Drum 2, un reproductor de samples de per­
cusión muy útil.

6.1 Recapitulación 
 

Hasta ahora hemos explorado dos de los sintes de la biblioteca de REAKTOR; ya es hora 
que echemos una mirada a uno de sus sámpleres.

▪ Vamos a aprender a reemplazar un sample de los mapeos con uno de nuestros propios 
samples.

▪ Aprenderemos a poner un sample en el mapeo.
▪ Vamos a seleccionar samples del mapeo con nuestro teclado MIDI y a escucharlos ha­

ciendo uso del ratón.
▪ También vamos a ver el mapeo de samples de REAKTOR.
▪ Finalmente, vamos a ver algunas propiedades del Memory Drum.

Volvamos a utilizar el buscador para cargar el Memory Drum 2.

Explorar el sampler de REAKTOR

 

REAKTOR 5.5 - Primeros Pasos - 73



Ilust. 6.1 Memory Drum 2

6.2 Usar el buscador para cargar el Memory Drum 2
 

1. En el panel lateral, pulse la ficha del Buscador para abrir el buscador.

Explorar el sampler de REAKTOR
Usar el buscador para cargar el Memory Drum 2

 

REAKTOR 5.5 - Primeros Pasos - 74



2. En el directorio de archivos, vaya hasta Ensembles > New Additions > Sample Player.
3. Haga doble clic en MemoryDrum2.ens.

Ilust. 6.2 Seleccionando Memory Drum 2 en el buscador.

Memory Drum 2 está mapeado para que C1 toque el primer sample y que con cada semi­
tono se ejecute un sample nuevo. Antes que nada, explore un poco los sonidos tocando 
tonos diferentes en el teclado. Tal vez los samples sean de su agrado, pero también es po­
sible que tenga ganas de poner alguno de sus propios samples. Si quiere hacer esto, debe­
rá abrir el editor de mapeos.
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6.3 Reemplazo y modificación de samples con el editor de mapeos
 

Ahora vamos a usar el editor de mapeos para sustituir algunos samples. Vamos también a 
activar el botón SEL BY KEY para que podamos tocar los samples del mapeo desde nues­
tro teclado MIDI y para poder usar el ratón para escuchar los samples.

6.3.1 Abrir el mapeo y tocar los samples
 

1. Haga doble clic sobre la onda del sample. El editor de mapeos se abrirá. Si lo desea, 
puede emplear también el botón de mapeo de samples de la barra lateral o utilizar direc­
tamente el atajo de teclado [F9].

2. Active la selección de samples por medio del teclado con el botón Key, ubicado arriba 
a la derecha. Ahora, podrá seleccionar los samples con su teclado MIDI.
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3. Haga clic en el botón de la escucha previa (Prehear) para escuchar los samples en su 
forma original.

Ilust. 6.3 El botón de pre-escucha (Prehear)

Vamos a sustituir algunos samples por algunos de los nuestros. Reemplacemos el sample 
de tambor de la nota MIDI 48. Primero, tendremos que seleccionarlo presionando la tecla 
C2 de nuestro teclado.

6.3.2 Usar la opción de reemplazo del menú de la lista de samples
 

▪ Abra el menú desplegable de edición (Edit), arriba a la izquierda del editor de mapeos, 
y seleccione Replace.
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Ilust. 6.4 La opción Replace reemplaza el sample seleccionado.

Esta acción debería abrir la carpeta con nuestros archivos de audio, seleccionada durante 
la configuración de las preferencias de REAKTOR. En el ejemplo, hemos reemplazado el 
tambor que ocupaba el lugar correspondiente a la nota MIDI 48.

6.3.3 División de teclas y nota raíz
 

Miremos de cerca el sample.

Ilust. 6.5 El editor de mapeos mostrando el sample Clap CloseTheBook.wav
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L y R presentan el valor de 48. Esto significa que la división de teclado de este sample es 
de solamente una nota: MIDI 48; lo cual resulta muy adecuado para un sonido de percu­
sión. La nota raíz también es 48. Esto significa que el sample se reproducirá con su tono 
original cuando está alojado en la nota MIDI 48.
Acabamos de reemplazar un sample, ahora vamos a mapear un sample nuevo.

6.3.4 Usar la opción de añadido del menú de la lista de samples
 

1. Vayamos hasta el último sample de la lista, el cual se encuentra sobre la nota MIDI 
77 y lleva el nombre de Sound 9.

2. Haga clic en el menú desplegable de Edit y seleccione Add.

Ilust. 6.6 Agregar un sample nuevo al mapeo de samples con la opción Add
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Ahora se abrirá la última carpeta que hemos utilizado para reemplazar el otro sample. Por 
supuesto, podemos elegir un sample de dicha carpeta o de cualquier otra. Un doble clic 
sobre el sample seleccionado lo cargará dentro del mapeo.

6.3.5 Editar la división de teclado
 

Vamos a editar la división del teclado para que L y R tengan el mismo valor de 78. Para 
cambiar el valor:
1. Haga doble clic sobre el número de la fila y columna correspondiente (aquí, la fila co­

rrespondiente a nuestro nuevo sample y la columna identificada con la letra R)
2. Escriba el número nuevo.
3. Al terminar pulse [Intro]. Como se ve, agregar nuevos samples es una tarea sencilla.

4. Si lo desea, ponga más samples. Cuando haya finalizado, cierre el editor de mapeo 
pulsando nuevamente el botón de Mapeo. En el apartado siguiente, visitaremos la in­
terfaz del Memory Drum.

Ilust. 6.7 El botón de Mapeo de samples

6.4 La interfaz del Memory Drum
 

Cada nota MIDI no solo selecciona un sample diferente, también puede seleccionar dife­
rentes características para cada sample.

6.4.1 Cambiar el tono de un sample solamente
 

Vayamos al primer sample que reemplazamos y cambiémosle el tono. En el Memory Drum 
es posible cambiar el tono de un sample sin afectar a los demás.
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▪ Haga clic en el deslizante de tono (identificado con una p) y arrástrelo hacia abajo:

Ilust. 6.8 Cambiando el tono (p) de un sample.

Ahora, ejecute el sample desde su teclado MIDI; debería escuchar un tono más bajo. Si 
toca otros sonidos, verá que los mismos suenan con su tono original. Esto es lo que hace 
único a este reproductor de samples de percusión. Con él podrá configurar los parámetros 
de cada sample de manera individual. Pruebe otras variantes: por ejemplo, cada nota con 
envolventes y filtros diferentes.
Sigamos explorando un poco más.
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6.4.2 Los snapshots del Memory Drum
 

Ilust. 6.9 La lista de snapshots del Memory Drum

El preset Default presenta las mismas configuraciones para todas las percusiones. Seleccio­
ne otros para escuchar las diferencias. Notará que las teclas no solo accionan samples di­
ferentes, también contienen configuraciones muy diversas. Puede agregar más samples y 
cambiar la configuración de alguno de ellos antes de guardar la versión de su ensemble. Si 
modifica algún snapshot, asegúrese de guardarlo como un snapshot nuevo (con el botón 
Append) y póngale otro nombre. Cuando haya finalizado la tarea de agregar o modificar sam­
ples, guarde su trabajo con Save Ensemble As.... Si no lo hace, todo su trabajo se habrá 
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perdido. En la guía del capítulo ↑8, Hacer un sampler con los módulos de REAKTOR, va­
mos a ver las distintas posibilidades que hay para reproducir un sample. También, apren­
deremos a transportar el tono de los samples en el editor de mapeos.
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7 Construir un sintetizador con macros
 

En esta guía vamos a construir un sintetizador de estilo analógico con algunas macros de 
fábrica. El sinte estará compuesto por dos osciladores, un mezclador,dos modeladores de 
envolvente y un filtro. Vamos a dar por sentado que usted ya ha leído las guías de los capí­
tulos previos y que está al tanto de las distintas técnicas de inserción y conexión.

7.1 Qué es una macro
 

REAKTOR cuenta con una gran biblioteca de macros. Una macro es una estructura prefa­
bricada que contiene un grupo de parámetros ya conectados entre sí y contenidos en su 
propio módulo con las entradas y salidas correspondientes. Una macro es como un instru­
mento pero más pequeño. Y es como un módulo, solo que adaptado para que pueda incor­
porar configuraciones más complejas de osciladores, filtros, envolventes, retardos, etc.; 
como los que podemos ver en los sintetizadores modulares. Cuando se convierta en un 
operador más avanzado, le resultará provechoso pensar sus construcciones instrumentales 
como si fueran objetos y separar de ellos los módulos que realizan determinadas operacio­
nes para "encapsularlos" dentro de una macro.
En el sintetizar ya terminado de abajo, las diferentes macros son los rectángulos de con­
troles encabezados por el nombre correspondiente.
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Ilust. 7.1 Sintetizador terminado

La macro Oscillator 1 contiene 3 osciladores dentro de su estructura y controles para el 
tono, la afinación de detalle, la amplitud y un interruptor de la onda. Estos controles cons­
tituyen módulos individuales y fueron conectados entre sí y colocados en una pequeña 
"carpeta" que denominamos con el nombre de macro.
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Ilust. 7.2 Estructura de la macro del oscilador

Los operadores avanzados, a menudo, seleccionan partes relacionadas de un ensemble, las 
cortan y las pegan en una nueva macro para analizarlas con mayor claridad y para emplearlas 
en otros armados.

7.2 Preparación
 

Vamos a empezar cargando un ensemble nuevo, vamos a borrarle el instrumento predeter­
minado y vamos a insertarle un instrumento más apropiado.

7.2.1 Cargar un ensemble nuevo
 

Carguemos un ensemble nuevo de REAKTOR:
1. Pulse el botón del Menú y seleccione File > New Ensemble.
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Verá aparecer el panel del ensemble.

Ilust. 7.3 Vista del panel de un ensemble nuevo

▪ Pulse el botón de Estructuras para ver la estructura correspondiente.

Ilust. 7.4 El botón de Estructuras
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Ilust. 7.5 La estructura de un ensemble nuevo

Trabajemos, ahora, sobre la estructura.

7.2.2 Eliminar el instrumento predeterminado
 

Como el sintetizador que queremos hacer tiene una sola salida, no vamos a necesitar el 
instrumento predeterminado con sus dos salidas.

▪ Para borrar el instrumento predeterminado, cliquee con el botón derecho del ratón 
(Windows®) o haga [Ctrl]+clic (Mac OS® X) sobre la parte superior del instrumento y 
seleccione la opción Delete en el menú contextual.
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Ilust. 7.6 Borrar el instrumento predeterminado.

Ahora tenemos que insertar un instrumento que tenga solamente una entrada, porque 
nuestro sintetizador no va a ser estéreo sino mono.

7.2.3 Insertar un instrumento nuevo
 

▪ Para insertar un nuevo instrumento, cliquee con el botón derecho (Windows®) o haga 
[Ctrl]+clic (Mac OS® X) sobre cualquier lugar vacío de la estructura para abrir, de es­
te modo, el menú contextual. Seleccione, luego, la opción Insert Instrument >_New – 
1in1out.
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Ilust. 7.7 Insertar un instrumento nuevo

El instrumento insertado contiene una entrada y una salida solamente.
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Ilust. 7.8 Instrumento insertado en la estructura

En nuestro sintetizador, necesitamos solamente la salida; procedamos entonces a borrar la 
entrada.
1. Abra el instrumento con un doble clic.
2. Con clic-botón derecho (Windows®) o con [Ctrl]+clic (Mac OS® X) sobre el módulo 

de entrada (In) abrirá el correspondiente menú contextual. Luego, seleccione la op­
ción Delete.

3. Vuelva a cliquear en algún lugar de la estructura para volver a la misma.

7.2.4 Conectar el instrumento a la salida de audio
 

Tenemos que conectar ahora la salida del instrumento con las terminales 1 y 2 de la sali­
da de audio.
1. Sitúe el curso sobre "Out" (o el puntito a su lado).
2. Cliquee y arrastre hacia el puerto de entrada 1 del módulo de salida de audio.
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3. Cuando llegue al 1 (o hasta el puntito) del módulo de salida de audio, habrá estable­
cido la conexión (representada por un cable de unión).

Repita la operación para conectar la salida del instrumento con el puerto de entrada 2 de 
la salida de audio. El sonido saldrá, de esta manera, a través de la salidas izquierda y de­
recha de su sistema de audio. La conexión que acabamos de realizar debería tener un as­
pecto parecido al de la ilustración. El indicador amarillo, situado abajo a la derecha del 
instrumento, confirma la conexión.

Ilust. 7.9 Instrumento conectado a la salida

7.3 Poner un oscilador y una envolvente ADSR en el instrumento
 

Ahora, tenemos que poner una macro de oscilador, una envolvente ADSR y efectuar las co­
nexiones correspondientes. También, tendremos que insertar un módulo para el tono (No­
tePitch) y otro para el supresor (Gate), para que podamos tocar el sintetizador a través de 
nuestro teclado MIDI.

7.3.1 Insertar un oscilador
 

1. Primero, asegúrese de estar en el interior del instrumento. Para ir al interior del ins­
trumento, haga doble clic sobre la representación del mismo.

2. Para insertar una macro de oscilador en la estructura del instrumento, haga clic-botón 
derecho (Windows®) o [Ctrl]+clic (Mac OS® X) sobre un lugar en blanco de la estruc­
tura y en el menú que se abre, seleccione Macro > Building Blocks > Oscillators > 
Osc (pls, saw, tri). Un oscilador de 3 ondas aparecerá en la estructura y en el panel 
del instrumento.
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3. Conecte ahora la salida del Osc 3 Wave con el combinador de voces de audio (repi­
tiendo la misma operación empleada para conectar el instrumento a las terminales de 
la salida de audio).

Ilust. 7.10 Oscilador conectado al combinador de voces de audio.
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7.3.2 Insertar una envolvente ADSR
 

▪ Cliquee (Windows®: clic-botón derecho, Mac OS® X: [Ctrl]+clic) en cualquier punto 
vacío de la estructura para abrir el menú contextual y seleccionar Macro > Building 
Blocks > Envelopes > ADSR – Env.

Ilust. 7.11 Insertando una envolvente ADSR.

7.3.3 Insertar los módulos de tono y supresión
 

Ahora falta agregar un par de componentes más ("módulos" en la terminología de REAK­
TOR). Los módulos NotePitch y Gate nos permitirán tocar el sintetizador con nuestro tecla­
do MIDI.
1. Cliquee (Windows®: clic-botón derecho, Mac OS® X: [Ctrl]+clic) en un punto vacío 

de la estructura para abrir el menú contextual y seleccione Built-In Module > MIDI In 
> Note Pitch para insertar el módulo de tono (Note Pitch) en la estructura.
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2. Repita el mismo procedimiento para seleccionar Built-In Module > MIDI In > Gate e 
insertar el módulo de supresión (Gate).

7.3.4 Conexión de los módulos del tono y del supresor
 

Hagamos ahora las conexiones necesarias.
1. Conecte el módulo NotePitch a la P (Pitch [entrada de tono]) del Osc 3 Wave.
2. Luego, conecte el módulo Gate a la G (Gate [entrada del supresor]) de ADSR-Env.
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3. Por último, conecte la salida superior de la ADSR-Env a la A (Amplitud) del OSC 3 
Wave.

Nuestro sinte debería presentar el siguiente aspecto:

Ilust. 7.12 El sintetizador con todas las conexiones realizadas

7.3.5 Volumen de salida seguro
 

Antes de tocar el sinte, comprobemos que el volumen de salida no esté muy alto.
1. Abramos, entonces, el panel del ensemble cliqueando sobre el botón de Paneles.

2. En el panel del instrumento maestro, pongamos el deslizante de volumen en -10.

Ilust. 7.13 Use el instrumento maestro para establecer un nivel de volumen seguro

Ahora toque unas notas y observe como el oscilador cambia el tono y arranca y se detiene 
cuando se presionan las teclas.

7.4 Insertar un filtro
 

Pongamos ahora la macro de un filtro.

Construir un sintetizador con macros
Insertar un filtro

 

REAKTOR 5.5 - Primeros Pasos - 96



7.4.1 Insertar la macro de un filtro y efectuar las conexiones correspondientes
 

1. Primero, asegúrese de estar en el interior del instrumento. Si se encuentra en el pa­
nel, pulse entonces el botón de Estructuras.

2. Luego, haga doble clic sobre la representación del instrumento para abrir su estructu­
ra.

3. Cliquee (Windows®: clic-botón derecho, Mac OS® X: [Ctrl]+clic) en cualquier punto 
vacío de la estructura para abrir el menú contextual y seleccionar la opción Macro > 
Building Blocks > Filters > 4 Pole Filter (BP, BLP, LP).

Efectuemos las conexiones correspondientes:
1. Conecte la salida (Out) del Osc 3 Wave a la entrada (In) del 4-Pole Filter.
2. Luego, conecte la salida del 4-Pole Filter a la entrada del combinador de voces de au­

dio (identificado con una llave "}")
El sintetizador debería presentar el siguiente aspecto:
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Acabamos de realizar las conexiones de la macro del filtro dentro de la estructura. Pase­
mos ahora a la vista del panel del instrumento. Observe que todas las macros aparecen 
una encima de la otra. Tendremos que desproteger el panel para corregir esto.

▪ Para acceder a la vista de los paneles, pulse el botón del Panel.

Ilust. 7.14 El botón de Panel

7.4.2 Desproteger el panel para poder mover las macros
 

Si el panel no está protegido, podremos mover las macros para que no aparezcan encima­
das una encima de otra.
1. Cliquee el botón de protección del panel para eliminar la protección del panel. Puede ha­

cer lo mismo empleando el atajo de teclado [Ctrl]+P (en Windows®) o [Cmd]+P (en 
Mac OS® X).
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Nuestro sinte debería presentar un aspecto parecido al siguiente:

7.5 Poner un oscilador más y un mezclador
 

Vamos ahora a poner un segundo oscilador, para que el sonido suene más grueso. Tam­
bién vamos a poner un mezclador y a efectuar las conexiones necesarias.
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7.5.1 Añadir un segundo oscilador con el comando "duplicar"
 

En vez de insertar otro oscilador y repetir todo el proceso, vamos a duplicar el que ya tene­
mos hecho.

▪ Vuelva a la estructura del instrumento y cliquee (Windows®: clic-botón derecho, Mac 
OS® X: [Ctrl]+clic) en la parte superior de la macro de Osc 3 Wave para seleccionar 
la opción Duplicate.

Ilust. 7.15 Duplicando el oscilador.

Una copia del Osc 3 Wave se insertará encima de éste.
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7.5.2 Usar las propiedades para cambiar el nombre de la macro del oscilador
 

Ambos osciladores tienen el mismo nombre, habrá que ponerles otro.
1. Cliquee (Windows®: clic-botón derecho, Mac OS® X: [Ctrl]+clic) en la parte superior 

del Osc 3 Wave y seleccione la opción Properties. La ficha de propiedades de la ma­
cro se abrirá a continuación.

2. En el campo del nombre, cliquee y arrastre sobre el texto que aparece y escriba enci­
ma el nombre "Oscillator 1"; luego, pulse [Intro].

3. Haga lo mismo con el otro oscilador y póngale "Oscillator 2".
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Ilust. 7.16 Escribir un nombre en el área del nombre de la ficha de propiedades.

7.5.3 Añadir un mezclador
 

Ya tenemos dos osciladores y ahora necesitamos un mezclador, para que los volúmenes 
respectivos cuenten con un poco de flexibilidad. Lo que necesitamos es un módulo con un 
amplificador y un mezclador. También, tendremos que hacer las conexiones necesarias y 
aumentar el número de entradas del mezclador.

▪ Para insertar el mezclador, cliquee (Windows®: clic-botón derecho, Mac OS® X: [Ctrl]
+clic) en una parte vacía de la estructura para abrir el menú contextual y seleccionar 
la opción Built-In Module > Signal Path > Amp/Mixer.
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Ilust. 7.17 Insertar el mezclador

Tenemos que conectar la salida de los Osciladores 1 y 2 al mezclador.
▪ Arrastre la salida de Oscillator 1 y conéctela con la entrada (In) de Mixer.
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Ilust. 7.18 El oscilador 1 conectado al mezclador.

7.5.4 Aumentar la entradas del mezclador
 

El mezclador (Mixer) cuenta con solo una entrada. Vamos a agregar entonces una segunda 
conexión.

▪ Para poner una segunda conexión, presione [Cmd] y arrastre (Mac OS® X) o pulse 
[Ctrl] y arrastre (Windows®) desde la salida (Out) de Oscillator 2 hasta el fondo verde 
del módulo de Mixer. Al llegar allí, se habrá creado un nuevo puerto de conexión.

Después de conectar la salida de Mixer con el módulo del 4-Pole Filter, el sintetizador ten­
drá el aspecto siguiente:

Ilust. 7.19 El mezclador conectado a ambos osciladores y al filtro.
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7.5.5 Poner deslizantes de volumen y conectarlos al mezclador.
 

Ahora hay que poner un par de controles deslizantes para controlar el volumen de los osci­
ladores.

▪ Cliquee (Windows®: clic-botón derecho, Mac OS® X: [Ctrl]+clic) en la entrada deno­
minada "Lvl" del módulo mezclador (Mixer) y seleccione la opción Create Control. Con 
esto, crearemos un control deslizante de volumen.

Ilust. 7.20 Empleo del menú contextual para crear un control sobre una entrada
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Ilust. 7.21 La conexión del deslizante de volumen.

Repita la operación con la otra entrad "Lvl" de Mixer. Ahora, ya tenemos dos controles de 
volumen.

7.5.6 Duplicar la envolvente ADSR
 

Antes de ponernos a ordenar todo, vamos a duplicar la envolvente ADSR para que poda­
mos usarla para modelar la envolvente del filtro. Como recordará, deberá cliquear (Win­
dows®: clic-botón derecho, Mac OS® X: [Ctrl]+clic) sobre ADSR-Env y seleccionar la op­
ción Duplicate. Tras conectar la salida de la segunda ADSR-Env con la entrada PM del 4-
Pole Filter, la estructura debería tener un aspecto parecido al del siguiente ejemplo:
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Ilust. 7.22 La estructura con una segunda envolvente ADSR.

7.5.7 Conectar el módulo NotePitch con las envolventes ADSR y con el filtro
 

Todavía nos falta realizar algunas conexiones importantes. El módulo NotePitch tiene que 
conectarse a todas las P de las macros. Esto recrea características verdaderas de los ins­
trumentos; en los que, cuanto más alta es la nota, más brillante y breve se vuelve el soni­
do.

▪ Para hacer esto, cliquee y arrastre el puntito rojo de salida del módulo NotePitch has­
ta todas las entradas P de las macros, incluyendo al ADSR-Env y al 4 Pole-Filter. Su 
estructura debería tener ahora el siguiente aspecto:
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Ilust. 7.23 Las conexiones adicionales del módulo NotePitch

7.5.8 Ordenar los instrumentos en el panel
 

Llegó el momento de que hagamos un poco de orden. Como recordará, tenemos que cli­
quear en el botón de protección del panel para desprotegerlo.

Ilust. 7.24 El botón de Protección del panel

Arrastre las macros por el nombre. Si el texto se pone rojo, significa que está selecciona­
do. También, puede arrastrar varias macros a la vez si dibuja una caja sobre los elementos 
que quiere arrastrar o, también, empleando [Shift]+clic. Mueva las macros hasta lograr al­
go parecido a esto:
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Ilust. 7.25 El panel del sintetizador tras el reordenamiento de las macros

Poner otro nombre a ADSR-Env
Como ya habrá podido apreciar, tenemos 2 macros ADSR-Env. Hay que cambiarle el nom­
bre a la segunda envolvente para que nos quede claro que está modulando el filtro. Para 
hacer esto vamos a emplear el cuadro de propiedades de la macro.
1. En la estructura del instrumento, cliquee (Windows®: clic-botón derecho, Mac OS® 

X: [Ctrl]-clic) en la macro de ADSR-Env que está conectada a la macro del filtro y en 
el menú que se abre seleccione la opción Properties.
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2. En el campo del nombre, cliquee y arrastre sobre el texto que aparece y escriba enci­
ma el nombre "Filter Env"; luego, pulse [Intro].

7.5.9 Cambiar el aspecto de los deslizantes de volumen
 

En REAKTOR, podemos cambiar la apariencia de los deslizantes para que tomen la forma 
de perillas. A veces, resulta una buena idea hacer esto porque las perillas ocupan menos 
espacio. Si se siente satisfecho con los deslizantes, puede saltear este apartado. Para 
cambiar el aspecto, vamos nuevamente a utilizar el cuadro de propiedades de REAKTOR y 
emplear el botón View.
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1. Cliquee (Windows®: clic-botón derecho, Mac OS® X: [Ctrl]-clic) sobre uno de los des­
lizantes para abrir el cuadro de propiedades.

2. Ahora, haga clic en el botón View para abrir la página de vistas.

3. Seleccione el diseño que desea emplear (es decir pasar de Vertical Fader a Knob).

4. Haga lo mismo con el otro deslizante. Ya que estamos, cambiemos también los nom­
bres de las perillas; escribamos Osc 1 Level y Osc 2 Level, respectivamente.
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7.6 Tocar el sinte y hacer cambios al sonido
 

Ahora, podemos explorar nuestro sintetizador, efectuar algunos cambios en los osciladores 
y el filtro, y crear algunos snapshots. Finalmente, guardaremos nuestro trabajo.

7.6.1 Cambiar la onda de los osciladores y restablecer el filtro y el volumen de salida
 

Seguramente, el sonido del sintetizador le sonará un poquito apagado. Pongamos, enton­
ces, una onda de sierra en el oscilador (botón Saw) y giremos la perillas de recorte (Cutoff) 
del filtro en sentido horario.
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Ilust. 7.26 Oscilador y filtros con la nueva configuración.

▪ También podríamos girar el volumen de salida hasta -20.

Ilust. 7.27 Un volumen seguro.

7.6.2 Crear algunos snapshots
 

Pruebe distintas configuraciones con las perilla Mod Amt. Este control ajusta la modulación 
de la envolvente sobre el filtro. También experimente con las perillas A, D, S y R (ataque, 
declive, sostenimiento y relajación) de ambas envolventes. También pruebe distintas con­
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figuraciones de tono (Pitch) y volumen (Level) de los dos osciladores. Cuando tenga una con­
figuración que le guste, guárdela como un snapshot. Como recordará, ya efectuamos esto 
cuando exploramos los 2-Osc y los sintes de Junatik.
1. En el panel lateral, haga clic en la ficha de Snapshots.

2. Pulse el botón Append, ubicado al final de la lista de snapshots.

3. Escriba el nombre del snapshot que está por incorporar y luego pulse [Intro].

7.6.3 Guarda el trabajo con "Save As"
 

Cuando haya confeccionado algunos snapshots, no se olvide de guardar su trabajo.
▪ Esta vez, utilizaremos los atajos del sistema operativo: en Windows®, presione [Ctrl]+

[Shift]+S (en Mac OS® X, [Shift]+[Cmd]+S) para ejecutar el comando Save Ensemble 
As… . Dado que hemos empezado con un ensamble nuevo, probablemente tendremos 
que volver hasta nuestra carpeta de usuario.
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8 Hacer un sampler con los módulos de REAKTOR
 

Vamos a construir un sampler con los módulos de REAKTOR

8.1 Recapitulación 
 

▪ Recapitulando lo hecho: hemos explorado algunos samples con el sampler Memory 
Drum 2.

▪ También hemos armado un sintetizador con las macros de REAKTOR.
▪ Y en este capítulo vamos construir un sampler empleando los módulos de REAKTOR.

8.2 Qué tipo de sampler
 

Vamos a construir un sampler que pueda reproducir bucles vocales, bordonas y efectos de 
sonido.
Los samples podrán ser reproducidos en todas direcciones (hacia adelante, en reversa y de 
adelante para atrás).
Vamos a confeccionar un sampler básico. Vamos a utilizar una envolvente y un un filtro, y 
haremos las conexiones pertinentes para los controles de la envolvente (ataque, declive, 
sostenimiento y relajación) y del filtro (recorte y resonancia).
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Ilust. 8.1 El sampler terminado

8.3 Armar la estructura básica
 

Comenzaremos de la misma manera que lo hicimos al armar nuestro sinte. Primero, vamos 
a crear un ensemble nuevo.

8.3.1 Cargar un ensemble nuevo
 

▪ Pulse el botón del menú y seleccione File > New Ensemble.
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Ilust. 8.2 Creación de un ensemble nuevo

En esta ocasión, vamos a usar el instrumento de entrada y salida estéreo predeterminado. 
Esto nos dará la opción de cambiar nuestro sampler por otro con salidas izquierda y dere­
cha.

8.3.2 Insertar los primero módulos
 

Vamos a insertar el módulo de sample junto con el de tono y el de supresión.
1. Haga clic en el botón de Estructuras para abrir la estructura del ensemble.
2. Abra, ahora, el instrumento presente en la estructura del ensemble con un doble clic.
3. Cliquee (Windows®: clic-botón derecho, Mac OS® X: [Ctrl]+clic) en cualquier lugar 

vacío de la estructura para abrir el menú contextual y seleccionar la opción Built-In 
Module > Sampler > Sampler.
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4. Ahora, insertemos los módulos del tono y del supresor. Como recordará, es lo mismo 
que hicimos cuando construimos el sintetizador. Abramos el menú contextual y selec­
cionemos, entonces, las opciones Built-In Module > MIDI In > NotePitch y, luego, 
Built-In Module > MIDI In > Gate.

Su estructura debería tener ahora el siguiente aspecto:
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8.3.3 Insertar una envolvente
 

Como paso siguiente, vamos a insertar la envolvente ADSR y controles para el ataque, el 
declive, el sostenimiento y la relajación.
Cliquee (Windows®: clic-botón derecho, Mac OS® X: [Ctrl]+clic) sobre un espacio de la 
estructura y seleccione Built-In Module > LFO, Envelope > ADSR.
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Ilust. 8.3 Inserción del módulo ADSR

8.3.4 Poner los controles de la envolvente
 

Vamos a emplear el mismo procedimiento que usamos para crear los deslizantes del mez­
clador del sinte.
1. Para ponerle un deslizante de ataque a la envolvente, cliquee (Windows®: clic-botón 

derecho, Mac OS® X: [Ctrl]+clic) sobre la A o el puntito rojo a su lado y seleccione la 
opción Create Control.
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2. Repita la operación para las entradas D, S y R de la envolvente.
La estructura debería tener ahora el siguiente aspecto:

8.4 Efectuar las conexiones
 

Tenemos que conectar el sampler a las salidas de sonido y conectar los módulos Gate y 
NotePitch con el sampler y la envolvente.
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8.4.1 Conexión del sampler con los 2 combinadores de voces de audio
 

1. El procedimiento ya es bastante conocido: arrastrar y soltar. Haga clic en la salida del 
sampler y arrastre hasta el combinador de voces de audio izquierdo.

2. Cuando haya alcanzado el puntito negro del combinador de voces de audio, suelte y 
habrá establecido la conexión.

3. Repita el procedimiento para conectar el combinador derecho.
El indicar amarillo confirma que la conexión fue llevada a cabo correctamente.

Ilust. 8.4 El Sampler conectado a los combinadores de voces de audio.

8.4.2 Conexión de los módulos NotePitch y Gate
 

1. Cliquee el puntito rojo del módulo NotePitch y arrástrelo hasta la P del Sampler.
2. Suelte y habrá establecido la conexión.
3. Repita el mismo procedimiento para el módulo Gate. Haga una conexión con la entra­

da "Trig" del Sampler y con la entrada G (Gate) del ADSR-Env.
La estructura deberá tener un aspecto parecido al siguiente:
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8.5 Cargar un sample en el sampler
 

Hemos construido un sampler bastante sencillo y vamos a probar ahora como funciona.
Primero, abra el editor de mapeos de samples

8.5.1 Abrir el editor de mapeos de samples desde el menú de vistas
 

▪ Haga clic en el botón de mapeos de la barra lateral

Ilust. 8.5 El botón de Mapeo de samples

Verá aparecer el editor de mapeos de samples bajo el instrumento.
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Ahora, repitamos lo mismo que hicimos cuando trabajábamos con el Memory Drum 2 y 
añadamos un sample al mapeo de samples.

8.5.2 Poner un sample en el editor de mapeos de samples.
 

▪ Para agregar un sample al mapeo, haga clic en el botón Edit y seleccione la opción 
Add.
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Ilust. 8.6 Empleo del menú de Edición para añadir un sample

A continuación se abrirá su carpeta de archivos de audio. Vaya hasta donde tenga guarda­
dos sus bucles de voces, efectos de sonido o texturas de bordona. Tras cliquear en "Open", 
el sample será colocado en el mapeo de samples.

Ilust. 8.7 Sample mapeado

Ahora, si toca su teclado MIDI, ¡debería escuchar el sample reproducirse con tonalidades 
diferentes!

Hacer un sampler con los módulos de REAKTOR
Cargar un sample en el sampler

 

REAKTOR 5.5 - Primeros Pasos - 125



8.6 Ordenar y mover los módulos
 

Tenemos que reordenar los módulos tanto en el panel de la estructura como en el del en­
semble.
Esto nos ayudará a ver las cosas más claramente y a crear espacio para poner otros módu­
los.

8.6.1 Mover los módulos dentro de la estructura
 

Ordenemos primero la estructura: arrastremos los módulos hasta sus nuevas posiciones.
1. Selecciones (con [Shift]+clic) los módulos NotePitch, Sampler, los combinadores y 

las salidas L y R.

2. Ahora, los arrastraremos hacia abajo a la izquierda.
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8.6.2 Eliminar los módulos innecesarios
 

1. No vamos a necesitar las entradas de audio L y R, por eso vamos a eliminarlas.
2. Seleccione ambos módulos (con [Shift]+clic).
3. Cliquee (Windows®: clic-botón derecho, Mac OS® X: [Ctrl]+clic) sobre uno de los 

módulos seleccionados y, en el menú contextual, seleccione Delete Selection para bo­
rrarlo de la estructura.
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Ilust. 8.8 La opción para borrar los módulos

8.6.3 Emplear el botón de protección del panel para mover las perillas
 

Los controles del ADSR aparecen unos encima de otros en el panel del ensemble. Tene­
mos que desproteger el panel para poder mover las perillas a otra posición.
1. Haga clic en el botón de Paneles para ver el panel del instrumento.

2. Cliquee el botón de protección del panel para eliminar la protección del panel.
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El instrumento debería presentar el siguiente aspecto:

Ilust. 8.9 Panel ordenado

8.7 Poner más samples y cambiar sus configuraciones
 

La idea de este sampler es mapear bucles de samples sobre diferentes teclas. Necesita­
mos entonces realizar algunos cambios en el mapeo de samples y poner, además, algunos 
samples más. Vuelva a abrir el editor de mapeos de samples.
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8.7.1 Cliquear la onda dos veces para abrir el mapeo de samples
 

Cliquee dos veces sobre la onda del sample para abrir el editor de mapeos de samples.

8.7.2 Cambiar la configuración de un sample
 

Antes de poner más samples, cambiemos el sample que tenemos. La idea es mapear 
nuestros samples sobre las teclas blancas, empezando por la nota MIDI 48.
Por lo tanto, primero nos aseguraremos de que nuestro sample se ejecute correctamente al 
tocar la nota MIDI 48. También queremos que el sample solo se reproduzca sobre esa no­
ta.

8.7.3 Modificar los parámetros de división de teclas y de tecla raíz
 

1. Si queremos que nuestro sample se ejecute con su tono correspondiente cuando to­
quemos la nota MIDI 48, primero deberemos cambiar la nota raíz. La misma está 
ahora en 60 y vamos a pasarla a 48. Hay que hacer, entonces, un doble clic en la 
columna Root y escribir el nuevo valor.

2. Dado que queremos tocar el sample solamente sobre esa tecla, deberemos activar el 
modo de tecla individual (Single Key Mode). Este modo se selecciona en el menú 
desplegable de edición (Edit).
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3. Ahora, hay que cambiar la división izquierda-derecha del teclado en función de la no­
ta 48. Seleccione, entonces, un sample, haga doble clic en la columna correspon­
diente (L o R) y escriba el nuevo valor. Pulse [Intro] para confirmar.

El sample se ejecutará únicamente con la nota MIDI 48 y en su tonalidad original.

Ilust. 8.10 Cambiando el mapeo del sample.
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8.7.4 Añadir más samples
 

Vamos a poner otro sample y mapearlo sobre la nota MIDI 50.
1. Volveremos a usar la opción Add del menú de Edición para añadir otro sample.
2. Ahora, mapeemos el sample de modo que la división de teclas izquierda (L) y derecha 

(R) esté puesta en 50.
3. Vamos a repetir este procedimiento para poner otros dos samples más. Como los que­

remos mapeados sobre las teclas blancas, el próximo sample que agreguemos tendrá 
L, R y Root puestos en 52.

4. El cuarto sample tendrá la nota 53 en L, R y Root.
Ahora, nuestros 4 samples se ejecutarán cuando toquemos las notas C2, D2, E2, y F2; es­
to es, las notas MIDI 48, 50, 52 y 53.
El mapeo de nuestros samples debería reflejar lo siguiente:

Ilust. 8.11 Los cuatro samples mapeados sobre teclas individuales

También, sería posible añadir otros samples sobre las notas MIDI 55, 57, 59 y 60. Pero 
para los fines de este ejemplo, vamos a ver ahora las distintas posibilidades de reproduc­
ción del sample. Aprenderemos a cambiar la dirección de la reproducción.
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8.8 Distintas posibilidades de reproducir los samples
 

Vamos a ver las maneras que hay para invertir un bucles y transportar el tono de los sam­
ples.

8.8.1 Los botones de bucleo y dirección
 

El sampler que fabricamos es bastante simple, pero cada sample puede poseer distintas 
características considerando el modo en que son reproducidos. Veamos algunas de estas 
características en el editor de mapeo de samples. Debajo de la onda del sample se en­
cuentra una serie de botones para el bucleo (Loop), la ejecución en reversa (Reverse) y el 
bucleo alternante (Alternate).

Ilust. 8.12 Botones y casillas de Loop, Reverse y Alternate

Los 3 botones aparecen apagados por defecto.
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1. Asegúrese de que el botón Key esté activado para que, de este modo, podamos usar el 
teclado MIDI para la selección de samples. Empecemos con el sample de la nota MI­
DI 48.

2. Ahora, haga clic en el botón Loop.
3. Use el teclado MIDI para tocar la nota correspondiente al sample que está editando y 

mantenga la tecla pulsada. Debería escuchar el bucleo del sample, que vuelve a em­
pezar de nuevo cada vez que llega a su fin.

4. Ahora, marque la casilla de Reverse.

Debería escuchar que el sample se buclea pero al revés.
Marque ahora la casilla de Alternate y el sample se ejecutará alternadamente al derecho y al 
revés.

¡Pruebe otras combinaciones!
Cada uno de los 4 samples puede tener distintas combinaciones.

También podría poner el mismo sample sobre 4 teclas y tener diferentes posibilidades de re­
producción.

8.8.2 Transportar un sample
 

Hasta ahora, los 4 samples están sonando con su tono original.
▪ Utilice la nota raíz (Root) para modificar el tono.
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En el ejemplo, hemos transportado el sample 7 semitonos abajo al cambiar la nota raíz por 
otra 7 semitonos más alto.

Ilust. 8.13 Transportación de un sample

8.9 Poner un filtro
 

Vamos a poner un filtro y crear controles para el recorte de frecuencias y la resonancia. 
Vamos a probar distintos tipos de filtros, como paso-alto, paso-banda y paso-bajo.

8.9.1 Insertar un filtro en la estructura
 

Haga clic (Windows®: clic-botón derecho, Mac OS® X: [Ctrl]+clic) sobre un espacio de la 
estructura del instrumento y seleccione Built-In Module > Filter > Multi 2-Pole.

Hacer un sampler con los módulos de REAKTOR
Poner un filtro

 

REAKTOR 5.5 - Primeros Pasos - 135



Ilust. 8.14 Insertar un filtro

8.9.2 Crear los controles del filtro y hacer las conexiones
 

Vamos a crear los controles P (Pitch Cutoff [recorte del tono]) y R (Resonancia).
1. Tal como ya lo hicimos antes, hay que cliquear con el botón derecho (Windows®) o 

hacer [Ctrl]+clic (Mac OS® X) sobre las entradas respectivas y seleccionar la opción 
Create Control.
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2. Ahora, conectemos la salida del Sampler a la entrada (In) del Multi 2-Pole y la salida 
LP (Low Pass [paso-bajo]) del filtro con los 2 combinadores de voces de audio.

Mueva los módulos para ordenar un poco todo y la estructura debería parecerse a los si­
guiente:

Ilust. 8.15 El filtro y sus controles dentro de la estructura.

8.9.3 Ordenar los instrumentos en el panel
 

▪ Nuevamente tenemos que desproteger el panel para poder mover las perillas de recor­
te (Cutoff) y resonancia (Resonance). Mueva las perillas para que no aparezcan en la par­
te de arriba del panel.

El instrumento debería presentar el siguiente aspecto:
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Ilust. 8.16 Panel ordenado.

8.9.4 Probar las salidas paso-banda y paso-alto - Guardar el trabajo
 

Cuando se trabaja con samples, a veces los filtros paso-banda y paso-alto resultan más 
adecuados que el filtro paso-bajo.
1. ¡Pero antes de hacer esto, vamos a pulsar el botón del Menú y seleccionar la opción 

Save Ensemble As… para guardar nuestro ensemble!
2. Ahora que el trabajo está guardado, podemos experimentar con las diferentes salidas 

de filtro. En la estructura del instrumento, haga clic en la salida BP del Multi 2-Pole 
y arrastre para establecer una conexión con los combinadores de voces de audio.
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3. Ahora toque su teclado MIDI y cambie las configuraciones del filtro y, si quiere, los 
controles del ADSR también.

4. Finalmente, conecte la salida de HP con los 2 combinadores de voces de audio. Lue­
go, seleccione la salida del filtro que mejor le convenga.

5. Guarde el trabajo.
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8.9.5 Usar la opción de 'guardar ensemble' para actualizar el sampler ya guardado.
 

Como ya anteriormente empleamos el comando Save Ensemble As... para guardar nuestro 
trabajo, ahora podemos usar el comando Save Ensemble para actualizar y grabar encima 
de la versión previamente guardada.

▪ Pulse el botón del Menú y seleccione File > New Ensemble.

Ilust. 8.17 Guardar el ensemble

Hay todavía una modificación que puede flexibilizar el filtro. Si le interesa, siga leyendo el 
próximo apartado. Si está conforme con el samples así como está, puede saltear dicha lec­
tura.

8.10 Modificar el sampler
 

Este apartado es para los que desean tener un filtro un poco más flexible.
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8.10.1 El selector del filtros
 

Sería interesante poder hacer transiciones entre los 3 filtros como forma fácil de decidir 
cuál de ellos es el mejor para nuestros samples. Si ponemos un selector de filtros, la es­
tructura tendrá finalmente el siguiente aspecto:

Ilust. 8.18 Estructura con el módulo de selección de filtros

Como puede ver, el Selector tiene 3 entradas y un deslizante de posición.
El deslizante de posición efectúa la transición entre los 3 filtros, desde el paso-alto hasta 
el paso-bajo, pasando por el paso-banda. Las transiciones se realizan suavemente, por lo 
que podremos tener, por ejemplo, un poco de paso-alto mezclado con un poco de paso-
banda. Ahora, vamos crear todo esto.

8.10.2 Insertar el selector
 

Vamos a insertar el módulo de selección y conectarle las 3 salidas del filtro. Después, ten­
dremos que crear un deslizante de posiciones y conectar la salida del selector con los 2 
combinadores de voces de audio.

▪ Cliquee (Windows®: clic-botón derecho, Mac OS® X: [Ctrl]+clic) sobre un espacio de 
la estructura y seleccione Built-In Module > Signal Path > Selector/Scanner.

Hacer un sampler con los módulos de REAKTOR
Modificar el sampler

 

REAKTOR 5.5 - Primeros Pasos - 141



Ilust. 8.19 Inserción del módulo de selección de filtros

8.10.3 Conectar las salidas del filtro
 

1. Primero, conectemos la salida HP del filtro con la entrada 0 del Selector.
2. Cliquee el punto negro de HP y arrastre hasta el Selector.
3. Cuando llegue al puntito azul de la entrada 0, suelte y la conexión se habrá completa­

do.
La entrada del Selector se volverá negra para confirmar la conexión de audio creada.
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Ilust. 8.20 Filtro y Selector conectados.

8.10.4 Aumentar la entradas del selector
 

Tenemos que crear un par de entradas más para poder conectar las 3 salidas del filtro.
1. Al arrastrar un cable desde la salida BP hasta el Selector, vamos también a mantener 

presionadas la teclas [Cmd] (Mac OS® X) o [Ctrl] (Windows®).
2. ¡Al llegar al Selector, habremos creado una nueva conexión!
3. Repita el proceso con la salida LP:

Ilust. 8.21 Las entradas del selector conectadas a las salidas del filtro
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8.10.5 Agregar el deslizante de posiciones y cambiar su rango de acción
 

1. Para añadir un control deslizante al selector, cliquee (Windows®: clic-botón derecho, 
Mac OS® X: [Ctrl]+clic) sobre la entrada denominada "Pos" y en el menú contextual 
seleccione Create Control.

2. Abramos las propiedades para cambiar el rango del deslizante. Cliquee dos veces so­
bre el deslizante para abrir el cuadro de propiedades.

3. Presione el botón Function para abrir la página de funciones.
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4. Ahora, ingrese 2 en el campo de Max.

La posición del deslizante recorrerá, ahora, los valores 0, 1 y 2. En consecuencia, se des­
plazará entre las 3 salidas del filtro.

8.10.6 Conexiones finales y ordenamiento en el panel
 

Finalmente, hay que conectar el Selector con los 2 combinadores de voces de audio.
▪ Vuelva a efectuar el procedimiento de conexión.

Hacer un sampler con los módulos de REAKTOR
Modificar el sampler

 

REAKTOR 5.5 - Primeros Pasos - 145



Después de realizar ambas conexiones y de mover el Selector, la estructura final se parece 
a la siguiente ilustración:

Ilust. 8.22 Todas las conexiones están hechas.

▪ Por último, desprotejamos el panel para poder mover el deslizante (haga clic en el bo­
tón de protección del panel y arrastre el deslizante hacia la derecha).

Ilust. 8.23 El botón de Protección del panel
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Ilust. 8.24 El deslizante de posición

▪ Vuelva a proteger el panel haciendo clic en el botón correspondiente.

8.10.7 Explorar el funcionamiento del sampler y hacer algunos snapshots
 

1. Hagamos ahora un par de cambios en el samples y guardemos algunos snapshots.
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2. Recuerde que hay que pulsar la ficha de Snapshots y usar el botón Append para poder 
guardar nuestro snapshot.

Ilust. 8.25 La ficha Snapshot

Ilust. 8.26 Usando el comando Append
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Como ya sabe, tiene que guardar su ensemble nuevamente para poder guardar los snaps­
hots recién creados. Puede usar el comando Save Ensemble o (si decide conservar la ver­
sión anterior del sampler sin el selector) emplear la opción Save Ensemble As..., y ponerle 
otro nombre.
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9 Lo que viene
 

Ahora que ya ha completado los distintos tutoriales de esta guía de iniciación, consulte los 
otros manuales que vienen con el programa para aprender técnicas de manejo más avan­
zadas. O puede visitar directamente los foros de REAKTOR de nuestro sitio de Internet pa­
ra enterarse de los últimos consejos y trucos, y para ampliar su colección de maravillosos 
instrumentos y ensembles.
¡Le deseamos mucho éxito con su REAKTOR y no se olvide de compartir sus creaciones 
con la comunidad de usuarios!
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